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1. THE MICROSOFT WORD WINDOW 

THE WORD WINDOW CONCEPTS  

Word is an application that runs under the Windows graphical user interface.  When 

launched, Word sits in its own “window” – the box that surrounds the application elements.  

The window can be moved, sized, closed, minimised and maximised using the features 

common to the Windows environment – these are listed below:  

WINDOW BORDER The box that surrounds the Word screen when it is not maximised is 

called the window border.  When the mouse is over the border, the pointer changes from a 

single to a double-headed arrow – clicking and dragging with this shape allows the window to 

be resized.  

TITLE BAR The coloured bar that appears at the top of the Word window.  The title bar tells 

you which application you are using and if the document you are in is maximised, it will also 

contain the name of the document.  If the Word window is not maximised, by positioning the 

mouse over the title bar and clicking and dragging, you can move the Word window to a new 

location on the screen.  

 

 

 

 

 

 

 

 

 

 

 

MAXIMISE BUTTON When working in a document, the Word screen contains two windows, 

an application window and a document window.  You can maximise both windows to 

capitalise on the space you have on-screen.   

If you would like the window that your Word application is in to fill up the whole 

Figure 1The Microsoft Word Window 

Tittle Bar Minimise button 

Close button 

Maximise button 

Task bar 

Vertical Ruler 

Scroll bar 
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screen, click the outermost maximise button.  You may find that the document you are in can 

still be bigger – click the inner maximise button to fill the remaining space within the Word 

application window.  

MINIMISE BUTTON This button is very useful if you need to temporarily switch from Word 

into another application without closing Word down completely.  Click the 

minimise button to shrink Word to an icon on the task bar; you will then be able to view 

other icons and applications you may wish to access.  When you are finished and ready to 

continue, click the Word icon from the task bar to resume.  The innermost minimise button will 

minimise the current document window.  

RESTORE BUTTON This button only appears when a window is maximised.  A maximised 

window has no border and you cannot see what is behind it.  If you want to put the 

window back inside its border so that you can move and size it, click the restore 

button.  

 

Figure 2 The Restore Button 

CLOSE BUTTON This button is used to close a window.  If you click the close button 

for a document window you close the document.  The last button will close the Word 

application.  

DIALOG BOX LAUNCHER this button launches dialog boxes specific to the part of 

the ribbon you see them the category will be named such as FONT, CLIPBOARD, etc  

 

 

 

 

BACKSTAGE VIEW – FILE RIBBON  

This view shows all the information about a document in one location. It displays many 

important commands and option used to manage and print documents such as view and edit 

document properties, and open, save, print and share documents..  This will be looked into 

much further later in the manual. 

 

 

 

Figure 3 The Dialog Box Launcher 

Restore button 
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Menus  

Menu’s are no longer used in Word they have been replaced by Ribbons and will be referred 

to as such throughout the manual  

Ribbons  

 

Ribbons are tabs that show different commands with respect to what you wish to do the 

HOME ribbon shows basic commands of formatting. 

   

Tabs on the Ribbon 

Groups on the Home Tab 
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The INSERT ribbon allows the insertion of any object.  Just click on the named ribbon to see 

list of commands that you can perform by clicking on the appropriate icon.  

 

Any Icon on the ribbon with a down arrow offers other options and sometimes a dialog box. 

E.G. Choosing QUICK PARTS in the TEXT group allows you to insert a field within your 

document or a document property adding information to your document that can be updated 

as the information is changed at source.  

Screentips  

Screentips are helpful hints that appear, to guide your 

choice to which command you may wish to apply. These 

can be useful when locating unfamiliar buttons or 

commands. 

  To view screentips  

Mouse  

(i) By holding your mouse over an 

icon, a helpful hint will appear to 

show you what that command will do. 

(ii)  Clicking will apply that command 

 

Contextual Tabs 
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Dialog Box  

 Clicking the DIALOG BOX LAUNCHER in the group type is a method to call up a dialog box 

from where you can make a choice from the various options and click OK at the bottom of the 

dialog box.    

 

 

 

 

If you wish to change your mind and close the dialog box without making a choice then click 

on CANCEL.  The dialog box will close without any choice being applied.  

Toolbars  

There are only two toolbars within the new version of Office 2010 there is the QUICK 

ACCESS TOOLBAR seen here next to the FILE TAB, and there is the MINI TOOLBAR 

Quick Access Toolbar  

This is a customizable toolbar placed by default above the Ribbon - you can add icons for 

frequently used commands to this toolbar. It can also be placed below the Ribbon. 

  

 

 

 To add a button to quick access toolbar  

Mouse  

(i) Click on drop down customisation menu for toolbar  

(ii) Select a button to add (let’s say the NEW button) the NEW button appears in 

QUICK ACCESS toolbar  

 

 

 

 

 

Dialog Box 
laucher 

Figure 4 The Dialog Box Launcher 

Customise Quick Access Tool Bar 
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( Draft )   
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Status Bar  

The Status bar, across the bottom of the screen, displays different information at different 

times.  To the left is an indicator, which will display which page you are currently on, which 

column you are in number of words in document.  If you right click on the empty area of the 

status bar a menu should appear showing the various items of information that can be given 

on the space bar merely click on the info that you wish displayed and it will appear on the 

status bar. 

 

Figure 5 The Status Bar 

To the right of the status bar are firstly, the different views that can be used within Word, and 

on the far right, the zoom control  

 

 

 

 

 

Status Bar 

Zoom Control 
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Scrollbars  

The Scrollbars are located along the 

right and bottom of the document 

window. They enable you to move to 

another part of the document by 

dragging the box or clicking the arrows 

in the scroll bar. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Vertical Scroll Bar 

Horizontal Scroll Bar 
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2. CREATING A WORD DOCUMENT 

Basic concepts to be learnt: 

1. Create new documents and save documents  

2. Close and Open files  

3. Enter information on the Word screen  

4. Understand the keyboard keys for word  

5. Edit information.  

6. Navigate using mouse and keyboard 

 

1. CREATING NEW DOCUMENTS AND SAVING DOCUMENTS  

 

When Word 2010 is launched at the beginning of a work session, it provides a blank 

document ready for you to start typing.  Word assigns the name “Document1” and this 

appears on the title bar at the top of the screen until you save the document and allocate a 

filename.  Each time a new document is created, Word will assign this temporary name with 

the number of the document going up in sequence (e.g. the second document created in any 

one session would be “Document2” and so on).  

 

STARTING WORD 2010 (Windows 7) 

Learning Example 2.1 

The ICT Seminar 

I went for a one day inovation ICT seminor for beginers. Seeing the speed and accuracy of 

the yong boys typing and operatng the computers, I was mesmerized and made up my 

mind to offer ICT so that I also become an expert. 

Am now learning to type! It is intresting but un familiar! I know I will make it one day. 

Required: 

(i) Type the text above as it appears 

(ii) Correct all the spelling and grammar errors in the document 

(iii) Save the document as My first doc on the desktop. 

(iv) Close the document. 

(v) Reopen the document 
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Starting a new Document 

When Word 2010 is launched at the beginning of a work session, it provides a blank 

document ready for you to start typing. 

But if Word 2010 is already open to get a new document: 

Mouse: 

(i) Click on File Tab 

(ii) Select New from the drop down menu 

(iii) Click Blank Document 

(iv) Select Create 

(v) A new blank document will be opened for you to start typing 

Or 

Keyboard 

(i) Press CTRL N 

(ii) A new blank document will be opened for you to start typing 

 

Typing and inserting Text 

 

To enter text, just start typing using the Keyboard! The text will appear where the blinking 

cursor is located. Move the cursor by using the arrow buttons on the keyboard or positioning 

the mouse and clicking the left button. 
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Word Wrap  

When you are typing in a document, Word has a feature called word wrap.  This is what 

makes the cursor automatically jump onto a new line when the text that you are typing has 

filled up all the space on the previous line.  Therefore the only time that you need to tell Word 

to begin a new line is if you want to start a new paragraph.  

Click and Type  

The cursor appears as a flashing vertical bar. To enter text, simply begin to type. If your 

cursor is at the top of the page and you wish to type text some way down the page, double 

click with the mouse to anchor your cursor in the desired location. This feature is known as 

CLICK AND TYPE.    

Note: Be aware that using this feature adds hidden characters into the document that may 

affect the appearance when formatting at a later stage. 

Inserting Additional Text 

 
Text can be inserted in a document at any point using any of the following methods: 

 Type Text:  Put your cursor where you want to add the text and begin typing 
 Copy and Paste Text:  Highlight the text you wish to copy and right click and click 

Copy, put your cursor where you want the text in the document and right click and click 
Paste. 

 Cut and Paste Text:  Highlight the text you wish to copy and right click and click Cut, 
put your cursor where you want the text in the document and right click and click 
Paste. 

Drag Text:  Highlight the text you wish to move, click on it and drag it to the place where you 

want the text in the document. 

Spell and Grammar Check 

 Word 2010 will automatically flag spelling and grammatical errors as you type.  A wavy red 

line under the error indicates spelling mistakes; a wavy green line indicates grammatical 

errors.  

 

 

Mouse 

(i) Move the mouse to place the 

cursor over the flagged word. 
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(ii) Right click: A short cut menu will pop with spelling options together with other 

options. 

(iii) Click on the desired spelling option. 

More of this feature is covered in the section on Proofing 

 

Saving Files   

Word gives any new document you create a temporary name – the word “Document” followed 

by a number.  The number increases by one for each new document you create in any one 

work session. The new standard for Word 2010 is that all files have a file extension added: 

.docx and previous versions of word will not be able to recognise this so beware of the 

filetype (extension) you save it as.  

 To save a file:  

Mouse 

(i) Click the SAVE button on the 

QUICK ACCESS TOOLBAR. If you 

haven’t saved the document 

previously, the SAVE AS dialog box 

will appear asking you for a 

document name and location.  

(ii) The first list box at the top and the 

box to the left allows you to 

navigate and determine the 

drive and folder that you want to 

save the document in.  The area 

below the SAVE IN list allows you 

to see which files are stored in the 

area currently displayed. 

(iii)  The FILE NAME box allows you to 

give the file a name before saving, Word will suggest a name based on the first line 

of text in your document. Just delete all in this box (or type over highlighted text)and 

enter just the name you want to call your file.   

(iv) The SAVE AS TYPE box allows you to determine what type of file you wish to save 

the document as:  A current version word document (default)  A word 97-2003 

version.  A text document  RTF format (rich text format) which can be read by most 

word processing packages that are non Microsoft it is a standard formatted 

document type.  Web page or Template  
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(v) When all options have been set click SAVE the dialog box will close the document 

will be saved and the filename will appear on the TITLE BAR at the top centre of 

the word window. 

OR 

(i) Click File 

(ii) Select “Save As” 

(iii) The dialog box seen above will appear and so proceed as before. 

Save Choices 

 To change the location:  

Mouse 

(i) Select on the left from either FOLDERS or LINKS 

(ii) Navigate on the left to the drive and folder of your choice. 

(iii) Use the BACK button in the top left to return to a previously viewed folder if you 

navigate too far. 

(iv) You may also use the double arrows in the top box to help you select a folder. 

When you have selected where you want to save your file we need to name it. 

 To name a file: 

Mouse 

(i) Click in the FILE NAME box and drag your mouse over the current file name ( if it is 

not already selected) – this will highlight it. 

(ii) Type the new name 

 To choose file type 

 Mouse 

(iii) Click in the SAVE AS TYPE box   

(iv) Make a selection from file types shown based on your need.  WORD DOCUMENT 

is the default but only people using 2007 and 2010 will be able to access 

Saving Changes 

To Files Once you have allocated a name to a file using the SAVE AS dialog, clicking the 

SAVE  button on the QUICK ACCESS TOOLBAR simply saves any new changes to the 

filename you originally gave.  It is worth saving files that you are working on every ten minutes 

or so, although an Autosave feature will backup your changes in case of a crash it is wise to 

save often. 

 To save changes to a file  
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Mouse 

(i) Click on the SAVE button on the QUICK ACCESS TOOLBAR. 

Or  

Keyboard 

(i) Press CTRL S.  If the document has never been saved before, the “Save As” dialog 

will appear, otherwise changes are saved to the file name that you have already 

allocated. 

Closing Files 

When you finish working on a file, you can close it down using the following methods: 

 To close the current file:  

Mouse 

(i) Click the FILE TAB and select CLOSE.  

Or  

Keyboard 

(i) CTRL F4.to close active document window. 

Or 

(i) Click on the CROSS in the top right hand corner of the document window.  

(ii) A dialog may appear, if you have unsaved changes to your document.  

(iii) Make a choice as necessary and the document will close. 

Note: 

If a warning “Do you want to save changes” appears 

while closing the file: Then you have changes you made to 

the document which are not saved. (Think twice before you 

chose either Save or Don’t Save, Cancel will leave the file 

active) 

 

Reopening saved Files   

(i) Open the file location where your file is 

(ii) If not desktop then open “This PC” or “Computer” for windows10 or windows7 

respectively. 
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(iii) Double click the desired file. 

Or 

Opening an Existing Document from the Word Window 

 Click the File Backstage menu and Click Open, or 
 Press CTRL+O (Depress the CTRL key while pressing the “O”) on the keyboard, or 
 If you have recently used the document you can click the File Backstage menu, click 

the Recent button and Click the name of the document in the Recent Documents 
section of the window. 

 

Recent 

You may also use the RECENT feature to open files.  When you use the same files regularly 

there is no need to have to navigate through all your folders to find a particular file. 

 To access recently used files: 

Mouse 

(i) Click on the FILE tab and select RECENT 

(ii) From the main window select a recently used file and click on it  

 

 

 

 

 

 

 

Document Views 
 

There are many ways to view a document in Word.   

 Print Layout:  This is a view of the document as it would appear when printed.  It 
includes all tables, text, graphics, and images. 

 Full Screen Reading:  This is a full view length view of a document.  Good for viewing 
two pages at a time. 
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 Web Layout:  This is a view of the document as it would appear in a web browser. 
 Outline:  This is an outline form of the document in the form of bullets. 
 Draft:  This view does not display pictures or layouts, just text. 

To view a document in different forms, click the document views shortcuts at 
the bottom of the screen  

Or 

 Click the View Tab on the Ribbon 
 Click on the appropriate document view.  

Learning Exercise 2.1 

(i) Type the text below using any word processing application program. 

How to conserve power for your PC  

Ever run out of battery pwer in the middle of a meeting? Has the urgent beep of your  
mobile PC's battery alarm made you the centre of attention during an executive  
presentation? Even with recent advancement in battery cell technology and in software that  
makes efficient use of power, you can do only so much work on a single charge. The trick is 
to get the most out of the power that is available. Chances are, you already have ways to  
make sure your mobile PC has power no mater where you are. May be you always carry  
the power cord or an extra battery for times when AC power isn't available. Those  
strategies wrk, but do you know to get the most out of the battery you'll be using during  
your next five hour flight?  

Required: 

(ii)  Type the text above as it appears 

(iii) Correct all the spelling and grammar errors in the document 

(iv) Save the document as PC Power on the desktop. 

(v) Close the document. 
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3. EDITING A WORD DOCUMENT 

Basic concepts to be learnt: 

1 Select desired text  

2 Move and Copy text  

3 Move and Copy text between documents  

4 Use the clipboard task pane  

5 Insert a file 

-  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select desired text  

In order to edit any text, it has to be selected/highlighted 

SELECTING TEXT  

Highlighting text with the mouse or keyboard is essential for most commands that you issue in 

Word as you normally select text and then perform an action on the selected text. When using 

the mouse to select text, the mouse pointer shape being displayed is important as you can 

Learning Example3.1 
 
Water  
Water is a common chemical substance that is essential fro the survival of all known forms of life. In typical 
usage, water refers only to its liquid form or state, but the substance also has a solid state, ice and a 
gaseous state, water vapour about 1,460 petatonnes (Pt) of water covers 71% of the Earth’s surface, mostly 
in oceans and other larger water bodies, with 1.6% of water below ground in aquifers and 0.001% in the air 
as vapour, clouds (formed of solid and liquid water. 
 
Water can disolve many different substances, giving it different tastis and orders. In fact, humans and other 
animals have developed senses to be able to evaluate the portability of water: animals generally dislike the 
taste of salty sea water and the putrid swamps and favour the pure water of a mountain spring or aquifer. 
Humans also tend to contain fewer microbes. The taste advertised in spring water or mineral water dervers 
from the minerals dissolved in it, as pure H2O is tasteless. As such, purity in spring and mineral water refers 
to purity from toxins, pollutants, and microbes. 
 
Water can appear in three phases. Water tkes many different forms on Earth: water vapour and clouds in 
the sky; seawater and rarely icebergs in the ocean; glaciers and rivers in the mountains; and aquifers in the 
ground. 
Required: 

i) Using a suitable word processor program typeset the above text as it is and save it as “water” 
ii) Copy the text on page 1 and paste it on page 2 of your document. 
iii) On the copied copy on page 2 apply the following:  

- Do all the spelling and grammar corrections 
- Cut paragraph three and paste it after paragraph one and before paragraph two. 
- Justify text alignment   
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perform different actions with different mouse pointers. The mouse pointer will appear as an 

“I” beam when your mouse is hovering over text in the document. However, when you hover 

your mouse in the selection bar (the left margin of the page), the mouse pointer will display as 

a right hand facing diagonal arrow. The diagram below shows you where to hover your mouse 

to get the different types of mouse pointer. 

 To select text  

Mouse 

(i) Use one of the actions in the table below to select the required amount of text.  

 Pointer 
Shape 

Action Result 

Mouse pointer 
hovering over text 

“I” Beam Click and drag over 
required text 

Highlights the text the 
mouse passed over 

 “I” Beam Double-click on a word Selects the word and 
the trailing space 

 “I” Beam Hold down the CTRL key 
and click the mouse over a 
sentence 

Selects the sentence 

From the selection 
bar 

 Click next to a line of text Selects the whole line 

 
 Click next to a line of text 

and drag down the 
selection bar 

Selects multiple lines 

 
 Double click next to a 

paragraph 
Selects the whole 
paragraph 

 
 Triple click in the selection 

bar 
Selects the whole 
document 

 

 To select text  

Keyboard 

(i) To select text using the keyboard, hold down the SHIFT key and follow the 

instructions in the table below to select the required amount of text. 

  

Action Result 

SHIFT  Select one character to the left 

SHIFT  Select from the cursor up one line 

SHIFT  Select right word by word 

SHIFT  Select from the cursor down one line 

SHIFT CTRL  Select left word by word 

SHIFT CTRL  Select up one paragraph at a time 

SHIFT CTRL  Select right word by word 

SHIFT CTRL  Select down one paragraph at a time 
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Action Result 

SHIFT HOME Select from the cursor to the beginning of the current line 

SHIFT END Select from the cursor to the end of the current line 

SHIFT CTRL HOME Select to the beginning of the document 

SHIFT CTRL END Select to the end of the document 

CTRL A  Select the entire document 

 

Selecting Non-Concurrent  

Text There is the ability to select areas of non-concurrent text. For example, you can select a 

paragraph at the top of a page and a sentence towards the bottom of the page. This then 

gives you the ability to perform an action (e.g. deletion, formatting) on the no concurrent areas 

of text you have selected.  

 

 To select items that are not next to each other:  

 

Mouse And Keyboard 

(i) Select the first item you want, such as a table cell or paragraph. 

(ii) Hold down CTRL and Click and drag anywhere on the page or within your 

document with your mouse to select any additional items you want. Keep CTRL 

pressed until all items have been selected. 

 

Move and Copy text  

Cut – Copy - Paste  

Having entered text or pictures in a document, you may decide that you need to reposition 

them or, you may want to use a paragraph in another document that you have created.  An 

extremely useful feature in any of the office applications is that once you have entered 

something once, you can move or copy it anywhere – to other Word documents or to files that 

belong to other applications. All Microsoft products use the same terminology when 

describing moving and copying items – CUT, COPY and PASTE. (These terms stem from the 

times when typesetters would lay out templates by physically cutting an item from its current location, and gluing 

or pasting it in to the new location.) 

 

Move and Copy text between documents  

Copying Items 

 To copy items: 

Mouse 

(i) Select the text that you want to copy. Click the COPY button on the HOME Ribbon. 

(ii) Move to the location where you want to place the text you copied. 

(iii) Click the PASTE button from the HOME ribbon the copied text will appear  
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Or   

Keyboard  

(i) Select the text you want to copy.  Press CTRL C to make a copy to the clipboard 

(ii) Move to the location where you want the copied text to go.  Press CTRL V to paste 

the copied text back in to the document  After copying you may paste your selection 

several times in different places. 

 

Inserting New Pages 

 

Word knows how many lines will fit onto a page and so as you near the limit; it will insert an 

automatic page break.  This may appear as a dotted line across the screen or you may see it 

appear as a new sheet of paper – the view that you are using will determine how the break 

looks.  You can put the page break inserting it manually as described below:  

 

 To insert a page break: 

Mouse 

(i) Position the cursor at the beginning of the line below where you want the page break.  

(ii) Choose INSERT PAGE BREAK from the PAGES group on the INSERT ribbon  

 

 

 

 

 

 

 

Or  

Page break button 
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Keyboard 

(i) Position the cursor at the end of the line above where you want the page to break. 

Press CTRL ENTER. 

 

Cutting Items 

 To cut items: 

Mouse 

(i) Select the text that you want to cut. Click the CUT button on the HOME Ribbon. 

(ii) Move to the location where you want to place the text you copied. 

(iii) Click the PASTE button from the HOME ribbon the copied text will appear  

 

 

 

 

 

 

Or   

Keyboard  

(iii) Select the text you want to copy.  Press CTRL X to move to the clipboard 

(iv) Move to the location where you want the cut text to go.  Press CTRL V to paste the 

cut text back in to the document  After cutting you may not be able to paste your 

selection several times in different places. 

 

EDITING TEXT  

Word provides two editing modes: INSERT and OVERTYPE. You can also delete the text you 

have already typed, undo or redo the changes.  

Insert & Overtype Mode  

The INSERT option needs to be selected from the STATUS BAR right click menu before this 

will be seen or is able to be used from the STATUS BAR.  

 

 To turn on/off overtype mode Mouse   

Cut 
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(i) Right click on status bar  

(ii) Click OVERTYPE to turn the feature on you should see the word INSERT in the 

STATUS BAR.  

(iii) Click the word once it should change to overtype.  

(iv) You are now in overtype mode  

(v) Click the word overtype in the status bar and it should change back to insert  

(vi) You are now in insert mode again.   

 To remove the feature from the status bar right click the status bar and uncheck 

overtype In INSERT mode (the default mode), means that any existing characters 

beyond the insertion point(flashing cursor) are moved ahead in the document as 

you type.   

 In OVERTYPE mode, the new characters you type replace the existing characters 

to the right of the insertion cursor.   

 The STATUS BAR tells you which mode you are in by displaying overtype when 

OVERTYPE mode is active.   

 Clicking on overtype switches between the two modes (i.e. if Overtype mode is on, 

click OVERTYPE on the status bar to switch it off). 

Typing Replaces Selection 

Overtype mode allows you to replace one set of characters with another; however, it can 

cause problems if you forget to switch it off, or if the number of characters you are replacing is 

different to the number of characters you are adding. While in normal insert mode however 

there is another method we use to replace text without the laborious task of deleting each 

character and then retyping.  

By selecting the text you want to replace and then typing replacement text, you have more 

control over what is deleted.   E.G. in the sentence below, you could change the word 

“previous” to the word “former” very easily by: 

(i) Double-clicking the word “previous” to select it.  

(ii) Typing the word “former”  

“Previous performances have included…….” 

Deleting Text  

Even the most perfect touch typists occasionally make mistakes!  If you need to remove text 

or add in extra characters, there are a variety of ways to do it.  

There are two main keys that remove text from a document, the DELETE and BACKSPACE 

keys.  The DELETE key is easy to find as it generally has the word “Delete” or “Del” written on 

it.  The BACKSPACE key is situated immediately above the ENTER key and usually has a 

backwards () arrow on it. The DELETE key removes a character in front of the cursor when 

you press it; the BACKSPACE key removes characters behind the cursor.  The key you use 
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to remove characters depends therefore on where your cursor sits.  The examples below 

illustrate the use of both DELETE and BACKSPACE.  

 To use Delete:  

Keyboard  

“feeeling”  

(i) With the cursor positioned in front of the extra “e”, use the DELETE key to remove it.  

 To use Backspace:  

Keyboard  

“feeeling”  

(ii) With the cursor positioned behind the extra “e”, use the BACKSPACE key to remove it. 

Deleting Whole Words  

You can boost the power of the DELETE and BACKSPACE keys by holding down the Control 

key as you press them.  (The Control key is the key marked CTRL and is generally situated in 

the bottom left and right hand corners of the keyboard).  CTRL DELETE removes a whole 

word in front of the cursor and CTRL BACKSPACE deletes a whole word behind the cursor.  

 To remove whole words:  

Keyboard  

“The course begins at 9 o’clock sharp”  

(i) With the cursor in front of the word “sharp”, use CTRL DELETE to delete it.  

“The course begins at 9 o’clock sharp”  

(ii) With the cursor behind the word “sharp”, use CTRL BACKSPACE to delete it. 

 

Joining a Paragraph  

To get rid of blank lines, you can use the DELETE and BACKSPACE keys as described 

earlier.  
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 To join a paragraph:  

Mouse  

(i) Place the cursor in front or behind the blank line you want to remove and press 

either the DELETE or BACKSPACE key.  

The Undo Feature  

With a selection made, typing new characters will replace that selection.  Obviously, this could 

cause problems for, if you accidentally touched a key with the whole document selected, you 

would replace all your text with the character that you pressed!  If this happens, or indeed if 

you do anything in Word and then regret your action at a later stage, you have the option to 

undo it.  During any one work session, Word keeps track of at least 250 of the most recent 

commands you have issued, and allows you to go back to the version of the document before 

you carried them out.  

 To undo the most recent action:  

Mouse  

(i) Press the UNDO button on the toolbar.  

Or  

Keyboard  

(i) Press CTRL Z. 

 To undo several actions:  

Mouse   

(i) Click on the downward arrow that sits just to the right of the 

Undo button.  This will drop down a list of the commands 

issued during the current work session   

(ii) Click the action you wish to undo – you will notice that if you 

choose say the sixth action in the list, Word undoes all commands from the sixth 

upwards.  

Redo  

The Redo button becomes available as soon as you have 

undone an action.    

  To redo an action:  

Mouse  

Undo 

Redo 
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Learning Example 3.2 
a) Using a word processing application of your choice typeset the following text as it appears.  

 
A computer is a device that simplifies work. It is a fast machine, it stores data and can be used to perform 
many other functions. A desktop computer comes with a system unit, monitor, keyboard and mouse. All 
these work together to help a user perform a task.  
 
Today, computers can be used at: 
home, 
schools,  
libraries,  
banks and many other places.  
 
A student can use a computer to store his work, create a time table, and communicate with other students 
from different campuses, etc.  
 
Required:  
b) Insert a title, “A COMPUTER” on your document, bold and underlined 
c) Copy and paste this work to page two of your document.  
d) On page two; Replace the heading “A COMPUTER” with, ‘Personal Computer’.  
e) Change the heading to upper case , Bold, underline and centred.  
f) Save your document as “ Word processor”. 

(i) Click the Redo button to redo the most recently undone command.  

Or  

Keyboard  

(ii) Press CTRL Y. 

 Repeat step one or two to redo more actions. 

If you simply want to repeat the last action, use F4, Word’s repeat key. 

Inserting a blank line for typing a new paragraph (the title): 

(i) Place the cursor at the beginning (point where we need the new paragraph) of the 

first paragraph. 

(ii) Press enter 

(iii) Then either click in the created blank line above or press the upper arrow  on the 

key board. 

(iv) Type the new Paragraph. 

 

Overwriting text (Replace text): 

(i) Highlight the text to be replaced. 

(ii) Type the desired text. (The highlighted text will be replaced with the new) 
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4. FORMATTING A WORD DOCUMENT 

Basic concepts to be learnt: 

1. Change the font style and size of characters  

2. Apply formatting effects to characters such as Bold, Italic and underline  

3. Change the alignment of paragraphs  

4. Indent paragraphs  

5. Use advanced font and paragraph formats  

6. Set tabs  

7. Apply borders  

8. Apply bullets and numbering 

 

 

 

 

 

 

 

 

 

 

CHARACTER FORMATS  

Word divides formatting into two types: Character formats and paragraph formats.  

 Character formats can be applied to individual characters within a document.  They 

include bold, italic and different font styles and sizes.   

 Paragraph formats affect whole paragraphs and control the layout of text on a page such 

as alignment, indents and so on.  

Word is best suited to applying formats to text that has 

already been typed.  It is often better to get the raw 

information in the document without worrying about 

how it looks and then going back afterwards and 

applying the formats.  

Learning Example 4.1 

Using the text in Exercise 3.1 

Required  

a) Complete all the requirements in exercise 3.1 

On page two: 

b) Change the title on page two to font style Arial Bold, font size 20, Upper case, Bold, underline and 

centred. 

c) Make the list below ’ Today, computers can be used at:’ bulleted 

d) Align the text below the title Justified and font style times New Roman, size 13. 

e) Apply a paragraph boarder around paragraph one. 

f) Shade paragraph two with light orange colour and Lt Trellis pattern. 

g) Increase the indentation of paragraph three by 1” 

h) Set the whole text on page two to 1.5 line spacing. 

Font Group 



NSS ICT Department 

 Page | 27  
 

Word Processing with Microsoft Word 2010 an Introduction 

Font Group  

The font group on the HOME ribbon contains buttons for applying some of the most 

commonly used formats.  

1. Font Style  

The font style (Font typeface) controls what individual characters look like.  True Type 

fonts will always look the same on screen as in a printed copy.  Some fonts are serifed 

(the characters have “curly” edges), whilst others are plain (sans serif).  

 

To change the font typeface: 

 Click the arrow next to the font name and 
choose a font.   

 Remember that you can preview how the new 
font will look by highlighting the text, and hovering over the new font typeface. 

 

  

 

 

 

 

 

 

OR  

Keyboard  

(i) Select the text to change.  

(ii) Press CTRL SHIFT F to open up the font dialog box focusing on the current font.  

(iii) Use the cursor keys to drop down the list of available fonts, use the up and down 

arrows to move the highlight bar up and down the list and ENTER to apply the 

chosen font to the selected text and close the dialog.  

To change the font size (Point Size): 
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2. Point Size  

This controls the size of the printed 

characters.  

 To change the point size:  

Mouse  

(i) Select the text to change.  

(ii) Click on the drop-down list arrow to 

the right of the currently displayed 

point size.    

(iii) Pick a new number from the list – the 

selected text will change size accordingly.  

Or 

 Click the Grow Font or Shrink Font size buttons.  

Or  

Keyboard 

(i) Select the text to change.    

(ii) Press CTRL SHIFT P to open up the font dialog box focusing on the point size.  

(iii) Either type the point size that you want to use (your typing will replace the 

currently selected number) or use cursor keys to move through the list of point 

sizes 

(iv)   Press ENTER to apply the currently highlighted size to the selected text and 

close the dialog Although Word displays from 8 to 72 points in the list, you can 

type your own numbers in and press  ENTER to apply the format. 

 

3. Character case, Bold, Underline and paragraph Alignment.  

Bold, Italic and Underline  

Bold, italic and underline can be applied to the selection using buttons on the 

formatting toolbar or keyboard shortcuts.  

 To change character Case: 

Mouse 

(i) Select the text to change. 

(ii) Click the Aa button on the toolbar. 

(iii) Select the desired case from the list and it will be applied. 

 

Grow Font Shrink Font 
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 To Apply bold, italic or underline:   

Mouse  

(i) Select the text to change.   

(ii) Click on either the B (for Bold), I (for Italics) or U (for 

underline) buttons on the toolbar.  The clicked button 

will “switch on” and the selected text will display the 

applied format.  

Or  

Keyboard  

(i) Select the text to change. 

(ii) Press CTRL B to apply bold formatting, CTRL I to apply italic formatting or 

CTRL U to apply single underline formatting to the selected text.  

 To Remove Bold, Italic and Underline:  

Mouse  

(i) Select the text with the format. 

(ii) Click the BOLD, ITALIC or UNDERLINE button to turn the format off. 

Or  

Keyboard  

(i) Select the text with the format. 

(ii) Press CTRL B, CTRL I or CTRL U to switch the format off.  

 To access extra underline styles 

Mouse  

(i) Select text to be underlined 

(ii) Click on drop down arrow to right of the U 

symbol to see more styles scroll until desired 

style is highlighted. 

(iii) Click on style to apply 

 To change underline colour  

Mouse  

(i) Select text to be underlined 

B, I, U Tools 
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(ii) Click on drop down arrow to right of the U symbol move to the UNDERLINE 

COLOUR option at the bottom to display colours  

(iii) Select colour to apply 

 

 To change Paragraph alignment 

Mouse 

(i) Select the Paragraph or Text to be 

aligned 

(ii) Select the desired alignment style 

from the Paragraph Group (Left align, Centered, Right align or Justify)  

4. Other Character/paragraph formats.  

(i) Text Highlights  

Just as you can use a fluorescent marker to highlight the salient points on a printed 

page, Word allows you to highlight text on screen.  

Highlights will show in the printed document in colour if you have a colour printer like 

this text, or in grey tones if you have a black and white printer.  

 To highlight text:   

Mouse  

(i) Click the drop-down list arrow to the right 

of the HIGHLIGHT tool. 

(ii) Select the desired Highlight colour from 

the list that appears.   

(iii) Drag your mouse over the text to 

highlight.  

(iv) Click the HIGHLIGHT button once more to switch the tool off.  

 To remove highlighting:  

Mouse  

(i) Select the text that has the highlighting.   

(ii) Click the drop down list arrow on the right of the Highlight button.  

(iii) Choose NO COLOUR to remove highlighting from the selected text.  

 To change font colour:   

Mouse  

(i) Select the text you want to change.   

Alignment Options 

Highlight tool 

Font colour button 
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(ii) Click the drop-down list arrow displayed on the right-hand side of the font colour 

button “A” and choose the desired colour.  

 To reset font colour:  

Mouse  

(i) Select the text you want to reset to the default colour.  

(ii) Click the drop-down list arrow displayed on the right-hand side of the Font 

colour button “A”.  

(iii) The Automatic option will reset text back to the default colour 

 

BULLETED AND NUMBERED LISTS  

Word has tools for automatically assigning bullets and numbers to lists.  You can choose from 

a variety of different number formats and select which bullet symbols to use.  You can also 

create multi-level lists very easily using this feature.  With numbered lists, if you move, delete 

or add items, Word will automatically renumber the list so that you always have the correct 

numeric sequence.  

Bullets  

Bullets are symbols that can be used to denote list items or headings.  They attach 

themselves to paragraphs within a document.  

 To create a bulleted list:  

Mouse  

(i) Type the list one value per line 

(paragraph) under the other. Or 

select the paragraph you desire 

to attach bullets 

(ii) Click the BULLETS button in the 

PARAGRAPH group to apply bullet 

symbols to your list using the 

default bullet style (the button will 

switch on).  

Or  

(i) Click on drop down arrow to right of BULLETS and choose one from the displayed 

choices. In Word 2010 when you apply bullets, your list is also automatically 

indented from the left margin. If you do not want this indentation you will need to 

remove it.  

Bullets Button 
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Stop using Bullets  

When you want to add a paragraph underneath your last list item, you may find that the 

bullets continue.  This is because bullets and numbers are paragraph level formats and 

Word will copy them from one paragraph to the next when you press the ENTER key. if 

you press ENTER a second time, Word will assume that you have finished your list and 

stop using bullets .  

 

 To switch bullets off:  

Mouse  

(i) Click the cursor on the paragraph where the bullet is, or if the bullets are on several 

paragraphs, select them.  

(ii) Click the BULLETS button in the PARAGRAPH group (the button will switch off)  

Or   

Keyboard  

(i) Click to position the cursor at the very end of last list item with a bullet.  Press 

ENTER twice. 

BORDERS  

Borders can be applied to many different objects in Word; for example, you can add borders 

to tables, paragraph edges or even whole pages in a document.  There are also some 

automatic formatting keystrokes that will add borders to the cursor position in your document 

(Seen in AutoFormatting).  

 To add a border to a paragraph:  

Mouse  

(i) Select the paragraph.  

(ii) Click on the drop down arrow to 

the right of the BORDERS 

button in the PARAGRAPH 

group on the HOME ribbon.  

(iii) Click on any combination of the 

border tools (from the displayed 

palette to the right) to determine 

which edges of the paragraph 

are bordered.  The buttons on the palette perform the following functions:  

Borders button 
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Applies or removes outside border  

  
Applies or removes borders both inside and outside  

  
Applies or removes top border  

  
Applies or removes left border  

  

Applies or removes a border horizontally inside a 

selection  

  
Applies or removes descending diagonal   

  
Applies horizontal line  

  
Applies or removes inside border  

  
Removes all borders  

  
Applies or removes bottom border  

  
Applies or removes right border  

  
Applies or removes a border vertically inside a selection  

  Applies or removes ascending diagonal  

 

Changing The Paragraph Border Width  

The width of the border is controlled by the right indent measurement belonging to the 

paragraph.   

 To reduce the width of the border:  

Mouse  

(i) Click in the paragraph with the border or select the paragraphs if more than one 

paragraph's borders need changing.  

(ii) Drag the indent markers on the ruler to correspond with the new border width. 

More Borders Via The Dialog Box  

Borders can be added using the borders dialog available from the borders drop down button.  

Applying borders in this way gives you more options as to line style, shading and so on.  
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 To apply borders using the Borders and Shading dialog:  

Mouse   

(i) Select the paragraph(s).to be 

bordered  

(ii) Click the drop down arrow to the 

right of the borders button in the 

PARAGRAPH group and select 

BORDERS AND SHADING the 

following dialog appears.  

(iii) Click on the BORDERS tab.  

(iv) Choose the required border 

style  

(v) Select a thickness or colour for 

the border  

(vi) Select an option from the left on where to apply the border OR Use one of the 

buttons on the left hand side of dialog to apply different borders top, bottom, left or 

right  

(vii) Click OK to apply borders to selected text 

Page Borders  

You are able to apply a border around an entire page. It is generally used in the same way as 

paragraph borders except you have an interesting addition, Art, where you have the 

opportunity to select an artistic page border. You may have to alter the border width so that it 

is not too big.  

 To apply a page border:  

Mouse  

(i) Select the drop down arrow to the right of the border 

tool button in the PARAGRAPH group and select 

BORDERS AND SHADING. (If the dialog has already 

been used then the BORDERS button will change and 

you only need to click it to bring up the dialog box).  

(ii) Click the PAGE BORDER Tab.  

Or  

(i) on the PAGE LAYOUT ribbon Click 

on the PAGE BORDER button in the 

PAGE BACKGROUND group  

Borders and shading 

Page borders 
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(ii) Select the appropriate border styles from the SETTINGS palette as you did for a 

paragraph border and apply them as before. Or i. Click the ART drop-down list to 

select from a range of graphics to use as a page border ii. Click OK. 

 

Shading  

The third tab within the Borders and Shading dialog allows you to apply shading to a 

paragraph or a piece of text.  

 To add shading:  

Mouse  

(i) Select what you want to shade (i.e. a word or phrase, or a whole paragraph).  

(ii) Open the BORDERS SHADING dialog as previous.  

(iii) Select the SHADING tab  

(iv) Choose a colour from the colour palette by clicking it.  

(v) If appropriate, choose a pattern from the pattern dropdown list and assign a colour 

to the pattern with the COLOUR drop-down list.  

(vi) Click OK. Do not apply patterns over text as you will not be able to read the text. 

Indents  

Indents allow you to control the white space at the left and right hand side of a paragraph. 

There are a variety of different methods for setting indents which are described below.  

 To indent from the left:  

Mouse  

(i) Click the cursor inside the paragraph whose indent you want to change or, if you 

are indenting several paragraphs, highlight them.  

(ii) Click the increase indent button (in the paragraph group) to indent the selected 

paragraphs by ½ an inch from the left. You can click this button again to increase 

by a further ½ inch and so on.  

(iii) If you need to decrease the indent by ½ inch, click the decrease indent button to do 

this.  

Or  

Keyboard  

(i) Click the cursor inside the paragraph whose alignment you want to change or, if 

you are aligning several paragraphs, highlight them.  

(ii) Press CTRL M to increase the indent of the selection ½ inch from the left.  

(iii) Press CTRL SHIFT M to decrease the indent by ½ inch.  
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Use The Ruler To Set Indents  

The buttons on the toolbar allow you to indent a set amount from the left only.  If you need to 

indent a paragraph from the right, or you want the indent to be a very specific amount, it is 

easier to use the ruler.  

 

The 

markers displayed above sit on the ruler.  The first line indent marker controls the first line 

position of the paragraph and the hanging indent marker the position of all lines following the 

first line. The left indent rectangle that sits under them maintains any gap between the first 

line marker and the hanging indent marker so the two can be moved together. The right 

indent marker controls where the paragraph ends. 

 To create a left indent using the ruler:  

Mouse  

(i) Position the cursor in the paragraph to indent or select the text if it includes more 

than one paragraph.  

(ii) Click on the rectangle (left indent) that sits on the ruler and drag this along the ruler 

– you will see a vertical guideline that draws itself down into your document to help 

you decide where the paragraph indent should be.    

(iii) Release the mouse to set the indent.  

 To create a right indent:  

Mouse  

(i) Position the cursor in the paragraph to indent or select the text if it includes more 

than one paragraph.  

(ii) Click on the upward triangle that sits on the right-hand side of the ruler (right indent 

marker) and drag this along the ruler – you will see a guideline that draws itself 

down into your document to help you decide where the paragraph indent should be.    

(iii) Release the mouse to set the indent.  

First Line Indent  
A first line indent is used where the first line of a paragraph needs to start further in than 
the other lines as in the example below:  

“It is company policy to ensure that all staff are fully trained in the use of the 
computer systems employed by the firm so that they may carry out their daily duties in the 
most efficient way.”  

 To create a first line indent:  

Mouse  

First line indent Hanging indent 
Left indent Right indent 
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(i) Position the cursor in the paragraph to indent or select the text if it includes more 

than one paragraph.  

(ii) Click on the downward triangle marker (first line marker) that sits on the left-hand 

side of the ruler and drag this along the ruler – a guideline appears that the first line 

will jump to when you release the mouse.  

 To remove the first line indent:  

Mouse  

(i) Position the cursor in the paragraph to change or select the text if it includes more 

than one paragraph.  

(ii) Drag the first line marker back so that it lines up with the other markers. Having 

created a first line indent, if you then want to indent the whole paragraph, use the 

rectangular marker (under the upward triangle).  Dragging this marker moves both 

the triangles 

Hanging Indent  

A hanging indent is used where the first line of a paragraph needs to start further back than 

the other lines as in the example below:  

“It is company policy to ensure that all staff are fully trained in the use of the computer 

systems employed by the firm so that they may carry out their daily duties in the most 

efficient way.”  

 To create a hanging indent:  

Mouse  

(i) Position the cursor in the paragraph to indent or select the text if it includes more 

than one paragraph.  

(ii) Use the left indent marker to indent the whole paragraph from the left the desired 

amount  

(iii) Drag the upward triangle (hanging indent marker) back along the ruler – a guideline 

will appear to show you where all lines (except the first line) in your paragraph will 

jump to when you release the mouse.  

Or  

Keyboard  

(i) Position the cursor in the paragraph to indent or select the text if it includes more 

than one paragraph.  

(ii) Press CTRL T  

 To remove a hanging indent:  
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Mouse  

(i) Position the cursor in the paragraph to format or select the text if it includes more 

than one paragraph.  

(ii) Drag the hanging indent marker back so that it lines up with the other markers.  

Or  

Keyboard  

(i) Position the cursor in the paragraph to format or select the text if it includes more 

than one paragraph.  

(ii) Press CTRL SHIFT T Having created a hanging indent, if you then want to indent 

the whole paragraph, use the rectangular marker (left indent, under the upward 

triangle).  Dragging this marker moves both the triangles but will keep any gap 

between them constant.   

Other Paragraph Formats  

The most commonly applied paragraph formats can be set using the buttons on the formatting 

toolbar as described in the previous section; however, there are further formats that can be 

accessed using the Paragraph dialog box.  

 To access the paragraph dialog:  

Mouse  

(i) Position the cursor in the paragraph to format or 

select the text if several paragraphs are involved. 

(ii) Clicking on the DIALOG BOX LAUNCHER in the 

PARAGRAPH group will open the PARAGRAPH 

dialog.  

(iii) This dialog box has two tabs, INDENTS AND 

SPACING and LINE AND PAGE BREAKS that are 

discussed below.  

Indents and Spacing Tab  

Most of the options on this tab are for formats that can be accessed through other means.  

The ALIGNMENT drop-down list allows you to pick one of the four alignment options that 

can also be applied using the formatting toolbar.  The INDENTATION options relate to the 

amount of left or right indent to be applied, and the SPECIAL and BY settings allow you to 

set up first line and hanging indents using the BY box to control the amount of each.  The 

options outlined below can only be applied through the dialog or via keyboard shortcuts. 

Spacing  
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Use these settings to control how much white space appears before and after the selected 

paragraph or paragraphs.  You can increase white space by inserting blank lines within your 

document. (i.e. pressing the ENTER key) but this can be time consuming and sometimes 

inconsistent.    

The Line Spacing list allows you to increase the space Word allocates between each 

individual line in a paragraph.  There are several settings which are described below: 

Multiple  

Choose this option and then use the AT box to give the number of lines by which you would 

like to space your paragraphs.    

The default is 3, but you can change the numbers either by using the arrows to increase and 

decrease, or by selecting the number and typing a new one over it. 

At Least  

With the At Least setting, if any of the characters within the selected paragraph are set to 

more than 18 pts size, the line spacing will adjust to accommodate it.   Choose this option and 

then use the AT box to give a minimum number of points by which your lines should be 

spaced out (e.g. 18 pts).    

Exactly  

With the Exactly setting, characters within the selected paragraph that are larger than the line 

space amount will be cut off.   Choose this option and then use the AT box to give an exact 

number of points by which your lines should be spaced out (e.g. 18 pts).    

 To change paragraph spacing:   

Mouse  

(i) Select the paragraphs to change and access the PARAGRAPH dialog, click the 

INDENTS AND SPACING tab.   

(ii) Click the up or down arrows on the right of the Before and After boxes to increase 

or decrease the number of points of space before and after – the numbers jump in 

increments of 6pts but you can select the number already there and type in any 

number of points as appropriate.    

(iii) The PREVIEW pane towards the bottom of the dialog shows what your 

paragraph(s) will look like.  

(iv) Click the OK button to confirm and close the dialog, or click CANCEL to close the 

dialog, abandoning any changes you have made to the settings within.  

 To change line spacing:   

Mouse  
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(i) Select the paragraphs to change.   

(ii) Access the Paragraph dialog and click the INDENTS AND SPACING tab.  

(iii) To space out the individual lines within a paragraph, first choose the amount of 

space you require by clicking on the drop-down list to the right of the LINE 

SPACING box.    

(iv) Select the required option detailing the amount of spacing to be applied, (Single, 

Double, 1.5).    

(v) The Preview pane towards the bottom of the dialog shows what your paragraph(s) 

will look like.    

(vi) Click the OK button to confirm the format change and close the dialog.  CANCEL 

closes the dialog, abandoning any changes you have made to the settings within. 

Keyboard Shortcuts for Paragraph Formatting  

It is possible to access all paragraph formats through the Format, Paragraph dialog box. 

However, it can be quicker to apply paragraph formats using keyboard shortcuts. Some useful 

shortcuts are listed in the table below.   

Keyboard shortcuts for paragraph formatting  

Single space lines CTRL 1  

Double space lines  CTRL 2  

Set 1.5 line spacing  CTRL 5 

Add or remove one line space preceding a paragraph  CTRL 0 

Centre a paragraph  CTRL E 

Justify a paragraph  CTRL J 

Left align a paragraph  CTRL L 

Right align a paragraph  CTRL R 

Indent a paragraph from the left  CTRL M 

Remove a paragraph indent from the left  CTRL SHIFT M 

Create a hanging indent  CTRL T 

Reduce a hanging indent  CTRL SHIFT T 

Remove paragraph formatting  CTRL Q 
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Learning Exercise 4.1 

i) Using a suitable word processing software, type this document as it is. 

TUBERCULOSIS (TB) IN AIDS  

The global war on AIDS could be lost if the world ignores tuberculosis, often a death sentence 
for people infected with HIV, former South African president Nelson Mandela warned at a 
global AIDS conference recently held in Bangkok. “The wold has made defeating AIDS its top 
priority. This is a blessing, but TB remains ignored”, said Mandela. He steered clear the 
controversay to focus on the plight of millions suffering from HIV and TB. 

About 14 million pple are infected with HIV and T.B, 70% living in Sub-Saharan Africa, the 
region hardest hit by HIV/AIDS, which has killed 20 million people worldwide. HIV, the virus 
which causes AIDS, destroys the immune system and makes patients more vulnerable to 
desseases such as TB, an infectious illness that accounts for up to-one third of all HIV/AIDS 
deaths  

“We cannot win the battle against AIDS if we do not also fight TB. TB is too often a death 
sentence for people with AIDS. It does not have to be this way”, Mandela said. He said 
resources for detecting and treating TB were woefully short despite the world having had a 
cure for it more than 50 years ago. 

(Adapted from: The New Vision, Monday, July 19, 2004) 

ii) Copy and paste the document to page 2 of your document. 
iii) Spell check your document. 
iv) Using the copy on page 2, centre, bold and underline the heading and make it font size 

24. 
v) Centre align the third paragraph and make it all italics. 
vi) Change the font colour of paragraph 2 to blue. 
vii) Increase the first line indent of all the paragraphs by 2 points. 
viii) Italicise the source of this document and make it font size 8 
ix) Shade paragraph with a light pink background. 
x) Insert a page boarder of dotted line on your document. 
xi) Save your work as My work on the Desktop. 
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5 TABS & TABLES  

Basic concepts to be learnt: 

1. Tabs and their uses within a document  

2. Insert a table  

3. Enter and format text in tables  

4. Navigate and select text  

5. Change the table layout  

6. Format tables 

 

TABS  

Tabs allow you to create simple tables of data that line up along a particular vertical position.  

You can also use advanced tab settings to create paper forms for print outs, or basic tables of 

contents.  Generally, these items contain dotted or solid lines for you to sign on or to indicate 

a page number for a topic - these lines can be generated with leader tabs.  

Alignment   

Basic tabs with alignment  

There are several different kinds of alignments with tabs we will explore some of them here.  

A LEFT TAB stop sets the start position of text 

that will then run to the right as you type. 

  

A CENTER TAB stop sets the position of the middle of the text. The text centers on 

this position as you type.  

A RIGHT TAB stop sets the right end of the text. As you type, the text moves to the 

left.  

A DECIMAL TAB stop aligns numbers around a decimal point. Independent of the 

number of digits, the decimal point will be in the same position. (You can align 

numbers around a decimal character only; you cannot use the decimal tab to align 

numbers around a different character, such as a hyphen or an ampersand symbol.)  

 

 A BAR TAB stop doesn't position text. It inserts a vertical bar at the tab position. 

 

 

Creating Leader Tabs  

Left Tab Stop 
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Use this feature to fill the empty space before a tab stop with dotted, dashed or solid lines. 

This effect is most commonly seen in a table of contents. The right aligned tab for the 

numbers in the example below has a dotted leader tab.  

Chapter 1 ........................................................ 1  

Chapter 2 ........................................................ 12  

Chapter 3 ........................................................ 20   

 To create a leader from an existing tab:   

Mouse  

(i) On the PAGE LAYOUT Ribbon, click the PARAGRAPH DIALOG BOX LAUNCHER.   

(ii) In the PARAGRAPH dialog box, click the TABS button. The TABS dialog appears.   

(iii) Select the tab stop in the TAB STOP POSITION: list.  

(iv) Choose one of the 4 Leader types. v. Click on the SET button to save the tab. vi. 

Click on OK to return to the document. You can also create the Tab from scratch in 

the Tab dialog box 

 

Default Tab stop  

Specifies amount of spacing that is applied each time you press the TAB key. 

 To change default tab stop  

Mouse   

(i) On the PAGE LAYOUT Ribbon, click the PARAGRAPH DIALOG BOX LAUNCHER.   

(ii) In the PARAGRAPH dialog box, click TABS.   

(iii) In the DEFAULT TAB STOPS box, enter the amount of spacing that you want 

between the default tab stops.   

When you press the TAB key, your tab will stop across the page at the distance that you 

specified.  

Set manual tab stops with ruler  

You might want to use the ruler to set manual tab stops at the left side, middle, and right side 

of your document.  If you don't see the horizontal ruler that runs along the top of the 

document, click the VIEW RULER button at the top of the vertical scroll bar.   

 You can quickly set tabs by clicking the tab selector at the left end of the ruler until it 

displays the type of tab that you want and then clicking the ruler at the location you 

want.   
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TABLES  

Tables give you the ability to lay information out in columns and rows easily understandable.  

An example of a table is shown below:  

Item  Action 
Word 2010 manual was discussed – deadline 
has now been set for end of next week. 

AM to complete manual and give a draft 
copy to HB for proof reading and revisions. 

 

Creating Tables  

Things to note: 

(i) A table is made up of rows and columns.  The rows and columns intersect to form 

boxes called cells. 

(ii) When a table is created, Word will make the table as wide as the current page 

orientation allows.  Therefore, if you know your table is going to be quite wide, you 

may want to switch to landscape before creating it.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Learning Example 5.1 
(i) Use any word processing program on your computer to type the following document as it appears.   

ITEM UNIT PRICE QUANTITY MAKE 

Copper Wire (1m) 3000 78 Uganda 

Circuit Breaker 45000 45 UK 

Bulb (Energy Saver) 7000 150 China 

Flat Iron 34000 15 UK 

Electric Cooker 150000 17 India 

Wall Socket 9000 55 China 

Extension Cables 60000 77 China 

A B C D 

Required: 
(ii) Insert a title: Wemba Electronics and Spare parts quotation above the table, bold and centre 

aligned. 
(iii) Delete all the contents of cells labelled A, B, C and D and Merge them all.  
(iv) Type the statement, “All prices are valid for 30 days only” in the merged cells. 
(v) Insert a new column to the left of “Item” Column. 
(vi) Merge all the cells in the new column and shade it light Grey. 
(vii) Type the text “Wemba Electronics & Spare parts Ltd” in the new column. 
(viii) Change the text direction in the new column to vertical. 
(ix) Save your document as Your Name – Electronics(e.g. Mubiru James – Electronics)  
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 To create a table:  

Mouse  

(i) Position the cursor where you want to 

insert the table. 

(ii) Click the table button on the INSERT 

ribbon, TABLES group.  

(iii) Do not click but move your mouse over 

the grid that appears, to highlight the 

number of columns and rows that you 

want your table to have. These will 

appear in your document and will 

continually adjust until you have all the 

rows and columns you need.  

(iv) Click the mouse.  The table will appear in 

your document at the cursor position.  

(v) Enter text into your table.  

Or  

(i) Position the cursor where you want to insert the table.  

(ii) Click the table button on the INSERT ribbon, TABLES 

group and click on INSERT TABLE from the menu.  

(iii) Under TABLE SIZE, select the number of columns and 

rows.   

(iv) Under AUTOFIT BEHAVIOR, choose options to adjust 

table size.   

(v) If you will use this table size regularly then tick the  

REMEMBER DIMENSIONS FOR NEW TABLES checkbox  

(vi) Click OK. Enter text into your table.  

Note: If you desire to extend or reduce the table, i.e. add more rows or 

columns or remove some rows or clumns: 

 

Adding rows or Columns 

(i) You can add new rows by pressing TAB when the cursor is in 
the last cell if you don’t know precisely how many rows your 
table will need. 

Or 

(i) Place the cursor in one cell and right click 
(ii) Select INSERT row above or below  

This will insert one row where you have specified 

Table Button 

Insert Table  
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Or 

(iii)  INSERT column to the left or Right 
This will insert one Column where you have specified 

 

Deleting Cells, rows or Columns 

You can remove/delete an undesired rows or column by: 

(i) Select the undesired Cells, Row or Column 
(ii) With the mouse pointer inside the selected row or column Right 

click 
(iii) Select Delete Cells, Row or column 

 
Inserting text above the table 

Mouse 
(i) Click above the table and type the required text 

Or 
If the table does not allow space above it then 

(i) Click in the first top left cell of the table 
(ii) Press Enter 
(iii) Click in the created space above the table Or press the UP arrow to move the 

cursor above the table then type the required text. 
 

Table Navigation  

When you are entering data into your table, you can simply click into different cells with your 

mouse to move your cursor around. This will allow you to enter text into different cells.   

However, you may find it faster to move around using the keyboard. The table below outlines 

some keyboard techniques for moving in a table:  

To  Press  

Move to the next cell   or TAB (If the insertion point is in the last cell of a 
table, pressing TAB adds a new row.)  

Move to the preceding cell  SHIFT TAB  

Move to the preceding or next row   or   

Move to the first cell in the row  ALT HOME, or ALT 7 on the numeric keypad (NUM 
LOCK must be off.)  

Move to the last cell in the row  ALT END, or ALT 1 on the numeric keypad  
(NUM LOCK must be off.)  

Move to the first cell in the column  ALT PAGE UP, or ALT 9 on the numeric  
keypad (NUM LOCK must be off.)  

Move to the last cell in the column  ALT PAGE DOWN, or ALT 3 on the numeric keypad 
(NUM LOCK must be off.)  

Start a new paragraph  ENTER  

Add a new row at the bottom of the table  TAB at the end of the last row  
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Add text before a table at the beginning of a 
document  

ENTER at the beginning of the first cell  

 

Enter Data in a Table  

You can enter text into each cell in your table – your text can even run to multiple lines 

within one cell. Working within a cell is almost like working on a very small page your text 

will wrap you can insert objects, set indents and numbering and the text can be formatted 

as usual.  

 To enter data in a table:  

Keyboard  

(i) Position the cursor in the cell where you want the information, and type it in.  

(ii) Press ENTER to start a new paragraph within the same cell or SHIFT ENTER to start 

a new line.  

Or  

(iii) Press TAB to move to the next 

cell.  

Select Items in a Table  

The table below outlines some methods for selecting table components:  

Keyboard  

To  Do this  

Select a cell  Click the left edge of the cell.   

Select a row  Click to the left of the row.  

Select a column  Click the column's top gridline or border.  

Select multiple cells, rows, or 

columns  

Drag across the cell, row, or column; or select a single cell, 

row, or column, and then hold down SHIFT while you click 

another cell, row, or column.  

Select text in the next cell  Press TAB  

Select text in the previous cell  Press SHIFT TAB  

Extend a selection to adjacent 

cells  

Hold down SHIFT and press an arrow key repeatedly  

Select a column  Click in the column's top or bottom cell. Hold down  

SHIFT and press  or  repeatedly  

Extend a selection (or block)  CTRL SHIFT F8, and then use the arrow keys; press ESC 

to cancel selection mode  

Reduce the selection size  SHIFT F8  

Select an entire table  ALT 5 on the numeric keypad (with NUM LOCK off)  
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Or 

Mouse 

(i) You can also select rows, columns, or the entire table by 

clicking on the table and then using the SELECT commands 

from the SELECT button on the LAYOUT ribbon, TABLE 

group  

 

 To format data in a table:  

Mouse  

(i) Select the data to format.  

(ii) Click the buttons to apply formatting from the HOME ribbon as discussed in earlier 

sections  

Note: Word treats each cell in a table as a separate document.  Be sure if you have have 

used the enter key in a cell and are applying paragraph formatting to select the 

appropriate paragraphs. This means that when you use alignment options for example, 

the data lines up between the edges of the CELL according to the selected alignment.  

Change Column and Row Size  

o The initial width of the columns and height of your rows for your table will depend upon the 

page orientation and how many columns or rows you selected to insert.  The standard 

widths that Word applies can be easily altered.  

 

 To change column widths and row height  

Mouse  

(i) Ensure that nothing in your table is highlighted (click away from any highlighting to 

remove it).  

(ii) Move the mouse over the right edge of the column whose width you want to change – 

the mouse pointer will change shape (see below).  

 

(iii) Click and drag the column edge to make the column wider or narrower as required.  A 

vertical guide appears as soon as you start dragging allowing you to preview the new 

position of the column edge and its width. 

(iv) Release the mouse.  The column will “jump” to its new width. 

Or 
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(i) In the CELL SIZE group in the layout ribbon enter the row and column size you 

wish for the selected row 

Text Alignment  

Because your rows and columns may have different quantities of data in them it may 

be necessary to align certain textual elements to various parts of the cell.  

 To align text  

Mouse  

(i) Select the cell or cells you wish to align the text for.  

(ii) Choose an alignment from the ALIGNMENT group on 

the LAYOUT tab.  

Note: If aligning the text does not put your text where you want it you may set the cell 

margins as you would for a document to line up your text perfectly  

 To set cell margins  

(i) Select CELL MARGINS from the ALIGNMENT group 

on the LAYOUT tab a dialog will appear.  

(ii) Enter required margin sizes for selected cells.  

(iii) Click OK to apply  

 

 To change text direction 

You may need text in a particular cell or the entire table to be vertical or other direction other 

than the default text direction 

To change text direction 

(i) Select the cell or cells you wish to change text direction 

for.  

(ii) Click Text Direction from the ALIGNMENT group on the 

LAYOUT tab until the desired direction is achieved. 

 

Merging and Splitting Cells 

When you have inserted your table there may be times in a number of 

cells that you would want them as one cell and not several and 

similarly you may wish for one cell to be split into several. In 2010 this 

feature is easy to do. Not only can you split cells but you can split a 

whole table into multiple tables if the need arises  
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 To split cells  

Mouse  

(i) Select the cell(s) you wish to split  

(ii) Go to the MERGE group on the LAYOUT ribbon and click the SPLIT CELLS button.  

 

 To merge cells  

Mouse  

(i) Select the cells you wish to merge.  

(ii) Go to the MERGE group on the LAYOUT ribbon and click the MERGE CELLS button.  

 

 To split Table  

Mouse  

(i) Click in the row that you wish to be the first row of the split table. 

(ii)  Go to the MERGE group on the LAYOUT ribbon and click the SPLIT TABLE button. 

(iii) The table will split above the row your cursor is in. 

Table Borders and Shading  

 

When you insert a table, Word automatically borders the outline and 

all the gridlines within – these will appear on a print out.  You may 

want to change the border style and colour or even remove the 

borders altogether.  You can also shade in parts of your table to 

emphasise them.  

You can decide which borders should appear in parts of the table, or 

in the table as a whole.  

 To choose the bordered edges:  

Mouse  

(i) Select the cell(s), row(s) or column(s) where 

you want to change which edges are bordered, or select 

the whole table.  

(ii) Click the drop down arrow on the right of the BORDERS 

button on the TABLE STYLES group on the DESIGN ribbon.  
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(iii) From the palette that displays, click the button that displays the required option to 

control which edges of the selection will have borders and which will not.  

Border Style  

 

You can change the line style, thickness and colour that Word uses to border the elements 

that make up your table.  We do this in Word 2010 by drawing the border around the cells.  

 To draw border  

Mouse  

(i) Click within your table  

(ii) Click on the DESIGN ribbon.  

(iii) On the DRAW BORDERS group select a line style from the topleft box (use drop down 

arrow) the DRAW TABLE button will be enabled  

(iv) Select a thickness for your border from the 

box beneath using the drop down arrow  

(v) Finally choose a pen colour from the 

button marked.  

(vi) Click on the border of a cell and drag along 

the border of a cell and release. A border 

will be applied with your selections.  

(vii) Repeat step around cell or table to apply your border formatting  

   

Table Shading  

You can apply shading to tables using an option on the TABLE STYLES group on the 

DESIGN ribbon.  

 To apply shading:  

Mouse  

 

(i) Select the cell(s), row(s) or column(s) 

where you want to apply shading or 

select the whole table if you want to 

shade the whole table.  

(ii) Click the drop down arrow to the right 

of the Shading colour button on the TABLE STYLES group on the DESIGN ribbon. to 

display a list of different colours.  

(iii) Click the required colour to apply it to your selection.  

Shading Button 
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You can remove shading by selecting the items that are shaded, clicking the 

Shading Colour button and choosing the No colour option  

Table Styles  

There are many predefined styles available to enable you 

to create a consistently formatted table quickly and easily 
that looks professional.  

 To apply a table style  

Mouse  

(i) Click within the table you wish to format.  

(ii) Move your mouse cursor over the various styles 

from the Design Tab. The style will preview on your 

table. When you have located the style you wish 

click and the style will be applied. 

Repeating Table Headings  

 

When a table spreads across more than one page, it can be useful to automatically 

repeat the first row(s) of the table on each page as the first row(s) will often contain 

headings that apply to the columns of the table. If you choose to repeat table 

headings, the rows you have chosen will automatically be inserted at the top of each new 

page the table spreads onto. To edit the heading rows or make formatting changes, you 

must go back to the top of the table as it is simply an image of the first row(s) on the other 

table pages.   

 To repeat table headings:  

Mouse  

(i) Select the rows that you want to repeat at the top of each page the table prints on.  

(ii) Go to the DATA group on the LAYOUT ribbon and click the REPEAT HEADER 

ROWS button  

Note: You will only see the repeating headings when you are in Print Layout or Print 

preview 
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Learning Exercise 5.1 
(i) Using a Word processing software of your choice on your computer type the text below as it 

appears. 

Course № Course Name Time Needed Period of Schedule Tuition Payable 

1 Introduction to 
Computer hw 

2 weeks 15th Jan to 30th Jan ₤25,000 

2 Input hw 1 month February ₤35,000 

3.  Processing hw 3 weeks 1st March to 20th March ₤30,000 

4.  Storage hw 1 month April ₤35,000 

5.  Output hw 1 month May ₤25,000 

 
(ii) Copy the table to page two of your document 
(iii) On the copy on page two 

a) Insert a row above the first row 
b) Merge all the cells in the new row 
c) Type a title “Time table for Computer Applications Certificate” in font size 15, upper case and 

bold 
d) Insert another row between course number 3 and 5, merge all the cells in it and type in the 

text, “Mid Term Examinations” in font size 14, uppercase, bold and underlined. 
e) Insert a column to the left of the Course No. column and Merge all the cells in it. 
f) Type the text, “Course Expectations” in font size 14, Bold and change its direction to vertical. 
g) Shade The Course Expectations column and the Time table row Light blue colour 
h) Change the font colour of the text in the title row to Red and in the expectations column to 

Dark blue 
i) Change the outer border of the table to Thick Red and the inside borders to 0.5pts Blue. 
j) Save your work as Compter certificate timetable 
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6 Images and Objects  

Basic concepts to be learnt: 

1. Auto shapes 

2. Clip Arts and pictures  

3. Objects  

4. Smart Graphics 

Microsoft Word allows you to use inbuilt pictures in documents for illustrations or emphasis. 

These are two types: Auto shapes and Clip Arts. 
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Clip arts 

These are Microsoft inbuilt pictures 

that can be used in documents and 

other office programs 

 To Insert a clip art 

(i) Place the cursor where you 
need the clip art 

(ii) On the Insert tab, click Clip 
Art.  

(iii) The Clip Art pane appears 
(iv) Type the search word for the 

desired clip art e.g. 
Computer 

(v) Clicking on the desired clip art will insert it where the cursor is 
 
Note: The inserted clip art can be resized using the sizing buttons on it. 
 

Auto shapes 

Learning Example 6.1 

(i) Open a new word document and type the text below as it appears 
 
Our school has given us the opportunity to learn ICT skills. We do word processing with Ms 
Word, Internet and web browsing and also computer maintenance. 
I can even draw pictures as you can see below! 
I trust I will be a computer expert in the future. 
 

(ii) Insert a clip art of a computer on the right top corner of your document. 
(iii) Insert two different Autoshapes of your choice 
(iv) Insert a Smart art below and type in the content as shown 

 

(v) Type the expression seen here as it is 𝑥 = −𝑏 ±
√𝑏2−4𝑎𝑐

2𝑎
 

(vi) Save your work as Shapes 

Top 
Admin 

Work 
group1 

Middle 
Manager 

Work 
group2 
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These are Microsoft inbuilt shapes that can be used in documents and other office programs 

for decoration or emphasis 

 To Insert an Autoshape 

(i) With the cursor where you need the Auto shape 
(ii) Click Shapes in the Insert Tab 
(iii) Click on the desired shape 
(iv) Click and drag the mouse where you want the 

shape to draw it to the desired size. 
 

 To Insert a Smartart/Graphic 

(i) With the Cursor where you need 

the Smartart 

(ii) Click Smartart in the Insert Tab 

(iii) Select the desired group of 

smartart from the left Pane of the 

dialog box 

(iv) Then select the desired graphic 

on the right and click OK to insert the graphic. 

(v) Click in the smartart positions where there is text and type in the desired text. 

(vi) More shapes can be added in the smartart by selecting Add shape in the Design Tab 

 

 To Insert objects 

(i) From the Insert Tab select Object 

(ii) Select Object 

(iii) Choose the type of object of your choice 

For Object like in question 6.1 (v) we select Microsoft Equation 3.1 then use the tools given 

Or  

(i) Use Equations from the symbols group 

(ii) Select Insert New Equation then use the tools given 

 

 

Object Button 

Symbols group 
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Learning Example 6.1 

i) Type the text below using a suitable application software program and apply the instructions that 
follow. 

Africa needs technology development fund 

Africa will not develop unless political leaders give priority to the development of Science and Technology, 
the chairman of Ghana Council of Scientific and Industrial Research has said. During a recent scientific 
conference at the UN Economic Hall for Africa in Addis Ababa, Ethiopia, Professor Edward Ayesu said: “it is 
important that African leaders establish a Technological Development Fund for Research and Development 
Institutions”. 

In attendance were ministers and government officials from Uganda, Guinea, Rwanda, Algeria and Tanzania. 
“We can design all types of research projects but if there no funds to execute them, they end up on paper,” 
he said, adding that the fund could also be used to give seed capital to young scientists to start new 
projects. 

Professor Lydia Brito of the University of Eduardo Mandlane said the science and technology appliquéd 
must be people-centred and based on the needs of particular countries. “We need social energy to solve 
local and global problems. We need to improve conditions of living and actions towards socio cultural and 
economic growth,” Brito Said. 

(Adapted from: The New Vision, Tuesday, April 22, 2008) 

ii) Make the title bold, centred, double underlined, font Tahoma, size 14 and colour blue. 

iii) Centre align the third paragraph and make it font style regular. 

iv) Drop cap the first letter of the second paragraph to three lines. 

v) Change the first and the second paragraph to font Monotype Corsiva and make them justified 

vi) Format the text in paragraph two into three columns of the same size. 

vii) Insert a graphic or a clip art of a computer in the first paragraph, and make the graphic to be behind 
text  

viii) Insert your name as a header in the middle and the word “Computer Class: as footer on the right 
side in a footer. 

ix) Set the margins as follows; left and right to 2 inches, top and bottom to 1.5inch. 

x) Find the word “said” and replace it with “told” 

xi) Change the line spacing of the document to 1.5 line spacing 

xii) Save your works as your first name. 

6 PAGE LAYOUT  
Basic concepts to be learnt: 

1. Insert page breaks  

2. Change margins and page orientation  

3. Create headers and footers 

4. Columns  

5. Number pages 

Drop caps 
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 To Insert Drop cap 

 
 
 
 
 
 
 

(i) Highlight the text you need to drop cap 
(ii) Click the Drop cap button in the Insert Tab 
(iii) Select the Drop cap option from the list 

Or 
Select Drop cap options at the bottom of the Drop cap drop down menu and select the 

desired options. 

 To format columns 

(i) Highlight the text you 

need to format into 

columns 

(ii) Click on the columns 

button in the Page 

Layout Tab. 

(iii) Select the column 

style from the drop 

down list. 

Or 

Select More Columns in the Columns drop down and select the desired options. 

 

Headers and Footers 

 To Insert Header or Footer 

(i) Click on the Header or Footer Button in the Insert Tab 

(ii) Select the Header of Footer style from the Drop down list 

(iii) Type the Footer or Header text or Paste an image. 

Or 

Select Edit Header or Footer then Type the Header or Footer text or paste an Image 
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Margins 

 To Margins 

(i) Click on the arrow below the Margins Button in the 

Page Layout Tab 

(ii) Select the Pre-set margins in the drop down list 

Or 

(iii) Select custom margins and 

specify the margins from the 

margins dialog 

Find and Replace 

 To use Find and Replace function 

The Find function helps you find any word, 

Phrase or Paragraph in a document 

(i) Click Find button on the Home Tab 

in the Editing group 

(ii) Type the text you desire to find in the 

document (Word will highlight it) 

 



NSS ICT Department 

 Page | 60  
 

Word Processing with Microsoft Word 2010 an Introduction 

Replace helps replace the found text with any desired text 

(i) Click Replace button in the Home Tab 

(ii) Type the text you desire to replace in the 

find what space 

(iii) Type the text desired in the Replace with 

space 

(iv) Click Replace or Replace All 

Pagination (Page Numbering)  

Word provides an automatic way of numbering the pages 

of your documents. 

 Inserting page Numbers 

 

(i) Click on the Page Numbers button on the Insert 

Tab 

(ii) Hover the mouse on the position you want the 

page numbers to appear 

(iii) Select the Numbering style from the drop down list 

 

Line Spacing 

Use these settings to control how much white space appears before and after the selected 

paragraph or paragraphs.  You can increase white space by inserting blank lines within you 

document. (i.e. pressing the ENTER key) but this can be time consuming and sometimes 

inconsistent.    

The Line Spacing list allows you to increase the space Word allocates between each 

individual line in a paragraph.  There are several settings which are described below: 

(i) Multiple  

Choose this option and then use the At box to give the 

number of lines by which you would like to space your 

paragraphs.    

The default is 3, but you can change the numbers either by 

using the arrows to increase and decrease, or by selecting 

the number and typing a new one over it.  

(ii) At Least  

With the At Least setting, if any of the characters within the 

selected paragraph are set to more than 18 pts size, the line 

spacing will adjust to accommodate it.    
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Choose this option and then use the AT box to give a minimum number of points by 

which your lines should be spaced out (e.g. 18 pts).    

(iii) Exactly  

With the Exactly setting, characters within the selected paragraph that are larger than 

the line space amount will be cut off.    

Choose this option and then use the AT box to give an exact number of points by which 

your lines should be spaced out (e.g. 18 pts).    

 To change paragraph spacing:   
Mouse  

(i) Select the paragraphs to change and access the 
PARAGRAPH dialog; click the INDENTS AND SPACING tab.   

(ii) Click the up or down arrows on the right of the Before and After boxes to increase or 
decrease the number of points of space before and after – the numbers jump in 
increments of 6pts but you can select the number already there and type in any number 
of points as appropriate.    

(iii) The PREVIEW pane towards the bottom of the dialog shows what your paragraph(s) 
will look like.  

(iv) Click the OK button to confirm and close the dialog, or click CANCEL to close the 
dialog, abandoning any changes you have made to the settings within.  

 To change line spacing:   

Mouse  

(i) Select the paragraphs to change.   

(ii) Access the Paragraph dialog and click the INDENTS AND SPACING tab.  

(iii) To space out the individual lines within a paragraph, first choose the amount of space 
you require by clicking on the drop-down list to the right of the LINE SPACING box.    

(iv) Select the required option detailing the amount of spacing to be applied, (Single, 
Double, 1.5).    

(v) The Preview pane towards the bottom of the dialog shows what your paragraph(s) will 
look like.    

(vi) Click the OK button to confirm the format change and close the dialog.  CANCEL 
closes the dialog, abandoning any changes you have made to the settings within. 

 

Character Spacing  

This Changes only the space between the individual characters without altering their size.  

 To change spacing:   

Mouse  



NSS ICT Department 

 Page | 62  
 

Word Processing with Microsoft Word 2010 an Introduction 

(i) Select the text to format.  

(ii) Access the FONT dialog and click the ADVANCED tab.  

(iii)  Click the drop down arrow to the right of the SPACING 
option.   

(iv)  Choose “EXPANDED” (more space between the 
individual characters) or “CONDENSED” (less space 
between the individual 
characters). 

(v) Use the BY box which has up and down arrows that can 
be clicked to increase or decrease by how many points 
(or tenths of points) the characters are expanded or 
condensed.   

 

Position  

“Normal” position places the characters on the same level as the other characters on that 
line.   You can choose to have text raised or lowered instead. 
  

 To change character position:  

Mouse  

(i) Select the text to format.  
(ii) Access the FONT dialog and click the CHARACTER SPACING tab.  
(iii) Display the list by clicking the arrow to the right of the Position box.  
(iv) Choose “RAISED” or “LOWERED” – the BY box then allows you to increase or 

decrease (again in tenths of points) by how much your characters should deviate from 
the base line position.  

Note: The BY boxes described above will allow you to type the number of points by which 
you want to change a setting rather than using the arrow keys to reach the desired 
figure.  Simply click inside the box to get a cursor, delete the number already there and 
type the new number. 

 

Keyboard Shortcuts 

It is sometimes quicker to use key combinations to apply formatting to text within a document 

and the table below lists the shortcut keys that you can use to do this:  

a) For Character Formatting 

Increase the font size  CTRL SHIFT >  

Decrease the font size  CTRL SHIFT <  

Increase the font size by 1 point  CTRL   

Decrease the font size by 1 point  CTRL    

Display the Format, Font dialog  CTRL D  

Change the case of letters  SHIFT F3  

Format letters as all capitals   CTRL SHIFT A  
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Apply bold formatting  CTRL B  

Apply an underline   CTRL U  

Underline words but not spaces  CTRL SHIFT W  

Double-underline text  CTRL SHIFT D  

Apply hidden text formatting  CTRL SHIFT H  

Apply italic formatting  CTRL I  

Format letters as small capitals   CTRL SHIFT K  

Apply subscript formatting (automatic spacing)  CTRL =  

Apply  superscript  formatting (automatic spacing)  CTRL SHIFT +  

Remove manual character formatting  CTRL SPACEBAR  

 

b) For Paragraph Formatting  

 

Single-space lines  CTRL 1  

Double-space lines  CTRL 2  

Set 1.5-line spacing  CTRL 5  

Add or remove one line space preceding a paragraph  CTRL 0  

Centre a paragraph  CTRL E  

Justify a paragraph  CTRL J  

Left align a paragraph  CTRL L  

Right align a paragraph  CTRL R  

Indent a paragraph from the left  CTRL M  

Remove a paragraph indent from the left  CTRL SHIFT M  

Create a hanging indent  CTRL T  

Reduce a hanging indent  CTRL SHIFT T  

Remove paragraph formatting  CTRL Q  
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6 TRIAL EXERCISES 
Trial Exercise 1. 

i) Type the following information as it is 

 

The time table below will be out by the beginning of next academic year.  

It should be copied and filled with relevant subjects. 

Senior Four Time Table 2010 

 8
:0

0
-9

:0
0
 

9
:0

0
-1

0
:0

0
 

B
R

E
A

K
 

1
0

:3
0

-1
1
:3

0
 

1
1

:3
0

-1
2
:3

0
 

L
U

N
C

H
 

2
:0

0
-3

:0
0
 

3
:0

0
-4

:0
0
 

Mon        

Tues       

Wed     FREE 

Thur       

Fri        

Sat    

Note:  The outer boarders are (3) triple lines. 

ii) Put a footer as your name and Class 

iii) Colour the title “Senior Four Time 2010” green 

iv) Shade the cells, “BREAK”, “LUNCH” and “FREE” with Dk Diagonal up green. 

v) Change the character spacing of the words “LUNCH and BREAK to 20 points 

vi) Change the font of the heading to Monotype Corsiva Bold and underlined 

vii) Change the rest of the text to Courier New. 

viii) Save your work as your Time table 

ix) Print your work 

 

Trial Exercise 2. 

i) Type the text below as it is using a word processing program  

 

CHOOSING WORD PROCESSING SOFTWARE 

Word processing is using a computer to enter, store, manipulate, and print text in letters, reports, books and so on. Once you 

have used word processing, you will probably wonder (like a million others before you) how in the world you ever survived 

without it. 

As more word processing packages come on market, choosing the right software can become very confusing. Nevertheless, 

there is probably a word processing package that will serve your needs. As you begin looking, ask yourself these questions: 

I. What type of documents am I  

o now producing? 

o Planning to produce? 

II. What types of features do I  

o need? 

o Want? 
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Document types can range from simple letters and memos to proposals, reports, legal documents, books, newsletters, 

scientific papers, form letters and so on. The point is, match the features you, need with the features in the software 

package. For example, if you write articles that require references, you will need the footnoting feature; if you develop a 

newsletter, having the multicolumn layout feature would be handy; if scientific notation is needed, you will want 

superscripts (X2 + Y2) and subscripts (A21); and if you send “personalised” form letters the mail-merge feature is a 

necessity. 

A number of add-on programs are available to enhance the functionality of word processing packages. These include: 

On-line thesaurus  

Spelling checker  

Grammar checker 

Style checker 

Idea processor (outliner) 

What you can do with word processing is limited only by your imagination and willingness to learn the system. Good luck 

in your Computer-assisted writing adventures-now and in the future! 

ii) Insert in the header the word “Tips” on the left hand corner and “Word processing” on the right hand corner in a 

footer. 

iii) Bold the heading, font size 22-point, underline and centre it 

iv) Block indent paragraph one by 1 inch in the right and left margins. 

v) In the paragraph starting with Document” bold the second sentence. 

vi) Make 2 the superscript of X and Y in the expression (X2 + Y2) and 21 the subscript of A in the expression (A21). 

vii) Insert bullets on the list of functionality of word processing packages given in the text. 

viii) Insert a footnote of your name and index number on the left and page number on the right hand corner. 

ix) Save your work as Choosing software and make a print out 

 

Trial Exercise 3. 

The following passage was the speech of the Kabambe High school’s Headteacher at the beginning of term – 1 2017.  

Question: Use any of the word processing programs and type the speech, after which you attempt all the parts in the 

required list 

 

Ladies and Gentlemen! You all know that the UCE results 2016 were very good but not good enough because we did not 

meet our target of 100% division one. The 96% first grade that we got we can still celebrate but we must not sleep!  

 

GRADE 1
st
 Grade 2

nd
 Grade 3

rd
 Grade 4

th
 Grade 7

th
 Grade Fail 

NO. 96 2 1 0 1 0 

Percentage 96 2 1 0 1 0 

 

Note: There is no miracle that is required for each of you to get division one. 

 

What do you lack, anyway? When I was a student no one visited me in school, no one! I had no pocket money like you but I 

persevered until I passed highly to join form six and eventually Makerere University! The only University by then! Why not 

you? The life in school is tough but you must be tougher if you must pull success on your way. Avoid excuses, they won’t 

take you anywhere! 

In order to succeed you must do the following: 

 Respect your teachers, fellow students and every other person around school. 

 Make a clear summary in all the subjects and ensure to revise regularly. 

 You must not dodge any lesson and ensure to do all the assignments in and outside class. 

 Do not be tempted to use any kind of narcotics, alcohol or abusive drugs as you will be destroyed! 

Thank you. 
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Required: 

i) Copy and paste the work you have typed in the new pages, two and three of the same document. 

ii) Change the font size in the first page to 13 and font style Tahoma. 

iii) Surround the first and second paragraph of page one with a thick border and shade the surrounded text with patterns of 

Dk Horizontal style and orange color. 

iv) Move to second page and format the first paragraph to two columns with a line in between the columns and 1.5” line 

spacing. 

v) Type a title, “Head teacher’s Speech to the first general assembly 2018” in bold caps on top of the speech 

        

vi) Indent the second paragraph of second page to 1” both left and right sides and then justify. 

vii) Convert the results given after the 2
nd

 paragraph into a table 

viii) In your table insert another column after “Fail” call it Total and use table formula to calculate the total number of 

students who sat for the examination. 

ix) Insert a title “Summary Results” on the table and a caption UNEB 2017 below the table.  

x) Still in the second page, format the bulleted list to numbering alphabets of capitalized letter styles. 

xi)  Format the third page work by character spacing to Expanded by 1.2”  style. 

xii) Insert page numbers in your document at the bottom right position. 

xiii) Insert a foot note “Noble men or Guys” on the word, “Gentlemen” in the paragraph 1. 

xiv) Insert a clip art of your choice as the school logo centred on top of the document with tight text wrapping. 

xv) Insert your full name as End Note. 

Save your work as Your name – The Speech 

 

 

Trial Exercise 4.  

You are the secretary to the school’s “Funds for Food” program and you are required to send out acknowledgement letters 

to people who have so far made contributions towards the program. The letter contents are the same for all the persons 

except the address, names and nature of contributions. 

 

Below is the letter to be sent and a table of people who have made contributions 

 

       Mukisa Senior Secondary School 

       P.O Box 21146 

       IGANGA 

       12
TH

 June, 2007 

 

[ADDRESS] 

Dear [NAME], 

 

Thank you for your contributions of [NATURE OF CONTRIBUTION] towards the “Funds for Food” program. 

 

This project is in its inaugural year but it has been a resounding successes. The learners and staff agree that it should 

become an annual event. The principal would like to thank you and hopes for more support in future. 

 

Thank you very much. 

 

………………………. 

PRINCIPAL  

NAMUKASA FLORENCE  
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Below is a table of people to receive the letter, their address and nature of contributions. 

 

 Name  Address Nature of contribution  

1 Lugayizi John P.O Box 14, Kamuli $430 

2 Musiime Molly P.O Box 92, Mbarara Shs 500,000 

3 Nsibambi Eriya  P.O Box 160, Buloba  20 kg of Maize  

4 Nakasolya Juliet P.O Box 1413, Kampala 40 bags of rice  

 

i) Use an appropriate method in any word processing program to make a letter to be sent to each person in the 

table. Save your works as “My letter” in a folder containing your name. 

ii) Type the table of recipients in another word processor file save it as address in the same folder created. The 

address and names should be bolded and the contributions in italics  

iii) Use an appropriate feature to link the table to the letter to produce four letters to be sent to each person. 

iv) Set the background of the document to have a printed water mark of your school. 

v) Insert page numbers at the top of a page using 1, 2, 3, … 

vi) Insert your name as a footer, italicize the footer in the centre. 

vii) Print each of the four letters. 

 
 
 
 
 


